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Financial Year-End 2020/2021   

 

 

A. Overview of Financial Year end 2020/2021 

 

The chart of accounts was revised in September 2019 to facilitate the reporting 

requirements of the Charities Regulator. In September 2020 codes were added 

to enable schools account for the COVID-19 Grants and the related expenditure. 

Further changes have been made to the Chart of Accounts as of August 2021. It 
is very important that the school’s chart of accounts is in alignment to the latest 

FSSU Chart of accounts. 

 

B. COVID Grants 

 

The accounting for COVID Grants and the related expenditure dominated the 

accounts function for the financial year and the Department of Education have 

requested that any unspent COVID-19 Capitation related grants for the 

2020/2021 school year should be repaid. They have requested it as one 

lodgement covering all grants (Enhanced Cleaning, PPE, COVID Aide and 

Enhanced Supervision as appropriate) and it should be returned by schools to the 

DE’s bank account by electronic funds transfer by 30th September 2021.  

 

To arrive at the correct repayment figure, it is vital that schools have recorded 

correctly all COVID costs paid from all the covid grants received under the correct 

covid code and that the accuracy of these postings is checked thoroughly. Where 

the Department report is used and relied upon to verify the repayment figure, it 

is crucial to check that every covid transaction is correctly allocated to that 

relevant covid department number in Sage 50. Please be aware that the COVID 

Minor Works grant should be excluded from this repayment calculation.  

Further guidance on the calculation of this COVID repayment is available here. 

 

C. Summary of key deadlines 

  

The school should aim to supply all financial information to their external 

accountant/auditor for the school year ending 31st August 2021 by September 

30th, 2021.  

Financial Guideline 2021/2022 – 04 
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Schools should consider setting up the Remote Data Access feature available in 

the upgrade to Sage 50cloud Accounts for the school accountant. This will enhance 

the efficiency of the school accounts preparation. The school accountant must have 

Sage 50 Client manager to avail of this system which allows for the authorised 

users to update, review, or amend the data in real time in a secure manner.  

 

D. Preparation for Year End 2020/2021 

• It is important that school’s chart of accounts is in alignment to the revised FSSU 

Chart of accounts so therefore it is advised to compare the current list of nominal 

codes in your schools Sage 50 with the revised FSSU chart of accounts to check 

for any inconsistencies. A current revised FSSU Chart of accounts is available here.  

 

• This will facilitate the inputting of the accounts into the FSSU Online accounts 

submission system by your external accountant/auditor and reporting of financial 

information to the Department and to the Charities Regulator. 

 

Before running the year end 2020/2021: Done 

1. Post all day-to-day transactions for the year. This ensures that 

your management reports and year end postings are accurate. 

Ideally any audit adjustments from the accountants should be 

posted to the income and expenditure codes within a reasonable 

time frame. 

 

2. Ensure you have bank statements for all school bank accounts 

covering the period 1st September 2020 to 31st August 2021 

and ensure all bank accounts are reconciled up to 31st August 

2021.  

 

3. Review the bank reconciliation report as follows: 

a. Review the list of outstanding payments and receipts on 

the bank reconciliation to ensure they are accurate.  

b. Any duplicate entries should be corrected.  

c. Any outstanding payments/receipt more than six-months-

old should be investigated. 

 

4. Ensure that the petty cash and credit card transactions are 

recorded for the year and that the balances in the petty cash 

and credit card account are correctly stated at the end of the 

year. 

 

5. Ensure that the balance in the Cash Control Account equates to 

the amount of cash and cheques held in the safe on 31st August 

2021. 

 

6. Ensure that the balance in the online payment solution clearing 

account (code 1870) equates to the amount of money owed from 

the online payments company at the 31st August 2021. 

 

https://www.fssu.ie/post-primary/topics/sage-50-accounts/chart-of-accounts/chart-of-accounts/
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7. Payroll records: Print individual employee payroll records for the 

period 1st September 2020 to 31st August 2021, print copy of 

the payroll summary for the 2020 year and have a backup of 

the payroll saved to a memory stick for 2020 and up to 31st 

August 2021  

 

8. VAT: Review ROS to ensure all VAT returns are filed. Remember 

you must file VAT returns even if liability is Nil. 

 

9. RCT: Ensure all deductions made from Subcontractors for RCT 

purposes have been returned to Revenue  

 

10. Parents Association: Ensure all financial documentation is made 

available to the school’s external accountant/auditor for inclusion 

in the annual financial accounts of the school.  

 

11. Complete a manual list of creditors at 31st August 2021 (money 

owed by the school). If using the purchase ledger print an 

outstanding creditors list at 31st August 2021.  

 

12. Complete a manual list of debtors & prepayments at 31st August 

2021 (money owed to the school). If using the sales ledger print 

an outstanding debtors list at 31st August 2021. 

 

13. Income received in the current year (2020/2021), for the next 

school year (2021/2022) should be shown as income received in 

advance on the balance sheet code 2105 and use the 

department function to analyse the various types within the 

nominal account. This will facilitate the running of a nominal 

activity report by department for code 2105 at 31.08.2021 for 

audit purposes.   

 

14. Alternatively, complete a manual list of income/grants received 

by the school in the year 2020/2021 that relate to 2021/2022 

school year e.g. book grant, transition year charges, school 

administration charges, voluntary contribution.  

 

15. Review the grants for the year to ensure that all grants received 

for the next academic year have been included in the accounts 

as ‘Grants Received in Advance (nominal codes 2150-2152).  

 

16. Review the income and expenditure for ring fenced grants and 

carry any unspent amounts forward as unspent grants.  

 

17. Ensure the balances of Covid grants unspent is correctly 

accounted for. (Webinar training to follow) 

 

18. Run a Nominal Activity Report and review the posting of 

transactions, to ensure they are accounted for correctly. 

 

19. Year-end Adjustments for creditors, debtors and income received 

in advance should be posted to SAGE 50 at 31.08.2021 before 

running year end if possible. 
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E. Print out the recommended Financial Reports for the year end. 

Reports To Run Reports 

Trial Balance Nominal codes > Trial Balance 
Nominal codes > Reports > Trial Balance 

Balance Sheet Nominal codes > Reports > My nominal code reports >BOM 
Balance Sheet 
 

Profit & Loss Nominal codes > Reports> My nominal code reports>BOM 
Income & Expenditure Account 
 

Nominal Activity  Nominal codes > Reports> Nominal Activity 
 

Unreconciled 
Payments / Receipts 

Bank accounts > Reports > Unreconciled transactions 
 

Aged creditors 
report 
(only for schools 
using the Supplier 
module) 

Suppliers > Reports > Aged creditors > Aged creditors 
summary  
Suppliers > Reports > Aged creditors > Aged creditors 
detailed 
Suppliers > Reports > Activity > supplier activity detailed 

Aged debtors report 
(only for schools 
using the Customer 
module) 
 

Customers > Reports > Aged debtors > Aged debtors analysis 
summary  
Customers > Reports > Aged debtors > Aged debtors analysis 
detailed 
Customers > Reports > Activity>customer activity detailed 
 

Department report 
for code 2105 

Department > Reports > Nominal Analysis > Nominal 
Department analysis detailed > nominal code 2105 and 
default on the dept numbers 
 

 
 
 

Department report  
 
For covid transactions 
 
 
 
 

Departments > Reports > Nominal Analysis > Nominal 
Department analysis detailed > department no 1 is covid in this 
example. I let nominal code default so it will give every code 
where dept 1 is assigned. 
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NB: If covid transactions were not assigned the relevant dept number then 
they will not appear in this report.  
 

 
 
 

 

 

E. System Back-Up 
 

Take A Minimum of TWO Backups and save to two separate locations (external 
hard-drive/Network). Name it ‘Before Year End’- it is essential to back up the 
data before running the year end, as this is the only way to go back to a pre-
year position.  
Please see Section G for running your year end in Sage 50. Further information 
or clarification on any of the issues raised in this Guideline can be obtained from 
the FSSU.  

 

F. Processing the Year End in Sage 50 
Schools should liaise with their external accountants/auditors and request them to 

review the school accounts as soon as possible and to return a draft Trial Balance 

which will include any changes to the income and expenditure for the year. The 

necessary audit adjustments can be inputted into Sage 50 before processing year 

end and the Income and Expenditure figures appearing in the archived accounts 

will substantially agree to the signed Financial Statements at 31.8.2020. If there 

are further changes after processing the year end, the adjustments can be made 

to the Balance Sheet codes dated 31.08.2021. 

Sage 50 has a soft year end, and this means you can post into your new financial 
year before running the Year End option. It's important to make sure the 
transaction date is correct. A message advises that the date is outside the current 
financial year, click Ok or Yes.  The following reports can be run for the new 
financial year until you run the year end - Transactional Profit and Loss, 
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Transactional Balance sheets and Transactional Trial Balances reports. Please note 
these reports are for internal/office use and should not be used for Board of 
Management meetings.  

To run the BOM reports for the new year which includes the budget for 2021/2022 
and prior year figures, the Financial Year End must be run in Sage 50. Therefore, 
this year-end process cannot be put off for audit adjustments for too long into 
the new Financial Year. 

If you use remote data access in Sage 50, you should run the year end routine on 
the computer that is designated as the main site under Help/ About in Sage 50. 
Where Sage is setup on a network, the year end routine should be run on the 
computer that holds the data. If you have a large dataset, it may take a little time 
to run the process. This time will be reduced if you run the routine on the computer 
that holds your accounts data. 

1. Running the Financial Year End 

• Change the program date-change the program date to be the last day of the 

financial year. e.g. 31st August 2021. 

• Take TWO backups labelled ‘Before Year End’- it is essential to back up the 
data before running the year end, as this is the only way to go back to a pre-
year position. It is advisable to take two backups as a precaution against loss or 
damage of the backup media. 

• To run the Year End, select Tools >Period End >Year End.  

• This will display the year end window and complete all the steps. 

• Archive Data – select the option to archive data. This will enable you to view 
old data without having to restore old backups.  

• Check the details shown at the bottom of the Year End window are correct 
before selecting the Run Year End option.  

• Click YES if the Year End dates are correct.  

• A year end progress screen will appear. Once complete you will be asked if 
you would like to print the Year End journal. Click ok. 

• A final message appears that the financial year end has been completed, click 
OK. 

 

2. Check Data After Running the Year End  

Run a Brought Forward trial balance. Select Modules >Nominal codes >Trial 
Balance for the period select Brought Forward 
 

• Make sure there are no income and expenditure codes on this report 

• Next, Check your data again. File>Maintenance > check Data 

• Finally take another backup of the data and label it ‘After Year End’ 
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• Do NOT clear the audit trail. However, if there are more than two years accounts 
data on Sage 50 and if Sage processing appears to be slowing down then clearing 
the audit trail should be considered. Please refer to our Sage 50 section of the 
website for details on this process. 
 
Full details on running the year end are in ‘FSSU SAGE Accounts Manual-Section 

8’. 

3. The School Budget for 2021/2022 should now be imported see ‘FSSU SAGE 
Accounts Manual -Section 2.7’ for guidance. 

 Please ensure that your budget import template has exactly the same nominal 
codes as exist in your Sage 50 accounts and that a backup is taken before 
importing the information.  

4. Once the year end is run, any audit adjustments for the 2020/2021 Accounts 
should be dated 31.08.2021 and should only be made to Balance Sheet codes with 
Income and Expenditure adjustments recorded in the Revenue Reserves code 2710. 

5. For those schools who want their Income and Expenditure Account showing the prior 
year, year to date comparatives instead of the full prior year, this optional report 
along with the instructions on how to copy into Sage 50 are available on the  
Getting started in Sage 50 section of our website. 

H. Upgrading to Sage 50cloud Accounts 

A reminder that all Voluntary Secondary Schools must upgrade to Sage 50cloud 

Accounts which brings the addition of new features including bank feeds and 
improvements in managing remote data access. Bank feeds will greatly reduce the 
amount of manual inputting and will therefore reduce the amount of time taken to 
process the monthly reports. Further details are available here. 

I. Sage 50 Training 

We are holding a series of Sage 50 training webinars over the next two months with 
particular focus on preparing for and finalising the year end.  

The FSSU will provide ongoing support and training to facilitate and assist schools with 
the new features available in Sage 50cloud Accounts starting with the use of bank 
feeds as this will enhance the efficiency and timeliness of the accounts function. 

Tel: 01-269 0677  

info@fssu.ie  

 

1st September 2021 

https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/post-primary/topics/sage-50-accounts/upgrading-to-sage-50cloud/schools-new-to-sage-50/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/upgrading-to-sage-50cloud/
mailto:info@fssu.ie
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Deireadh na Bliana Airgeadais 2020/2021   

 

A. Forléargas ar Dheireadh na Bliana Airgeadais, 2020/2021 

Rinneadh athbhreithniú ar chairt na gcuntas i Meán Fómhair 2019 chun riachtanais 

tuairiscithe an Rialtóra Carthanas a éascú. I Meán Fómhair 2020 cuireadh cóid 

leis chun a chur ar chumas scoileanna cuntas a thabhairt ar Dheontais COVID-19 

agus ar an gcaiteachas gaolmhar. Rinneadh tuilleadh athruithe ar an gCairt 

Chuntas i mí Lúnasa 2021. Tá sé thar a bheith tábhachtach go mbeadh Cairt 

Cuntas na scoile i gcomhréir le Cairt Cuntas i déanaí FSSU. 

 

B. Deontais COVID 

 

Bhí an chuntasaíocht do Dheontais COVID agus an caiteachas gaolmhar chun 

tosaigh ar fheidhm na gcuntas don bhliain airgeadais agus d’iarr an Roinn 

Oideachais go n-aisíocfaí aon deontais neamhchaite a bhaineann le Caipitíocht 

COVID-19 don scoilbhliain 2020/2021. D'iarr siad go ndéanfaí é a sholáthar 

mar thaisceadh amháin a chlúdódh na deontais go léir (Glantachán Feabhsaithe, 

TCP, Cúntóir COVID agus Maoirseacht Fheabhsaithe de réir mar is cuí) agus ba 

cheart do scoileanna é a sheoladh ar ais chuig cuntas bainc na RO trí aistriú 

leictreonach cistí faoin 30 Meán Fómhair 2021.  

 

Chun teacht ar fhigiúr ceart na n-aisíocaíochtaí, tá sé ríthábhachtach go mbeadh 

gach costas COVID a íocadh ó na deontais uile a fuarthas faoin gcód covid ceart 

a bheith taifeadta i gceart ag na  scoileanna agus go ndéanfaí cruinneas na 

bpostálacha sin a sheiceáil go críochnúil. Sa chás go n-úsáidtear agus go mbítear 

ag brath ar thuarascáil na Roinne chun an figiúr aisíocaíochta a fhíorú, tá sé 

ríthábhachtach seiceáil a dhéanamh go ndearnadh gach idirbheart covid a 

leithdháileadh i gceart ar uimhir ábhartha covid na Roinne i Sage 50. Tabhair 

faoi deara gur cheart deontas Mion-Oibreacha COVID a eisiamh ón ríomh 

aisíocaíochta seo. Tá tuilleadh treorach faoi ríomh na haisíocaíochta COVID seo 

ar fáil anseo. 

 

C. Achoimre ar na príomh-spriocdhátaí 

  

Ba cheart don scoil gach iarracht a dhéanamh an fhaisnéis airgeadais uile maidir 

leis an scoilbhliain dar críoch an 31 Lúnasa 2021 a sholáthar dá 

cuntasóir/hiniúchóir seachtrach faoin 30 Meán Fómhair 2021.  

Treoirlíne Airgeadais 2021/2022 – 04 

 

 

 
Meánscoileanna Deonacha 

 

 

 

Teach Emmet, Baile an Mhuilinn, Baile Átha Cliath 14  
Guthán: 01 2690677 R-phost: info@fssu.ie 

   

 

https://www.fssu.ie/post-primary/topics/sage-50-accounts/chart-of-accounts/chart-of-accounts/
https://www.fssu.ie/post-primary/topics/return-of-unspent-covid-capitation-funding-supports/
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Ba cheart do scoileanna machnamh a dhéanamh ar an ngné Rochtana Sonraí 

cianda a chur ar bun agus a sholáthar do chuntasóir na scoile. Tá an ghné sin ar 

fáil san uasghrádú ar Chuntais Sage 50cloud. Cuirfidh sé seo le héifeachtúlacht 

maidir le hullmhú na gcuntas scoile. Caithfidh bainisteoir Cliant Sage 50 a bheith 

ag cuntasóir na scoile chun leas a bhaint as an gcóras seo a chuireann ar chumas 

úsáideoirí údaraithe na sonraí a nuashonrú, a athbhreithniú nó a leasú i bhfíor-

am ar bhealach slán.  

 

D. Ullmhú do Dheireadh na Bliana 2020/2021 

• Is tábhachtach go mbeadh Cairt Cuntas na scoile i gcomhréir le Cairt Cuntas 

athbhreithnithe FSSU; mar sin, moltar an liosta reatha cód ainmniúil in Sage 50 

do scoile a chur i gcomparáid le Cairt Cuntas athbhreithnithe FSSU chun a 

sheiceáil an ann d’aon neamhréireachtaí. Tá cóip de Chairt Cuntas 

athbhreithnithe FSSU ar fáil anseo.  

 

• Éascóidh sin obair do chuntasóra/d’iniúchóra seachtraigh maidir le iontráil na 

gcuntas i gcóras seolta cuntas ar líne FSSU, agus tuairisciú faisnéis airgeadais don 

Roinn agus don Rialálaí Carthanas. 

 

Sula ndéantar tuarascálacha deireadh bliana 2020/2021 a rith: Déanta 

1. Déan na hidirbhearta uile ó lá go lá i gcomhair na bliana a 

bhreacadh síos. Ar an mbealach sin, is féidir a áirithiú go bhfuil 

do chuid tuarascálacha bainistíochta agus breacadh dheireadh 

na bliana cruinn. B’fhearr aon choigeartuithe ó na cuntasóirí a 

bhreacadh leis na cóid Ioncaim agus chaiteachais laistigh de 

thréimhse ama réasúnta. 

 

2. Áirithigh go bhfuil ráitis bhainc agat maidir le cuntais uile na 

scoile, lena gcumhdaítear an tréimhse ón 1ú Meán Fómhair 

2020 go dtí an 31 Lúnasa 2021 agus áirithigh freisin go bhfuil 

na cuntais bhainc go léir réitithe suas go dtí an 31 Lúnasa 

2021.  

 

3. Déan athbhreithniú ar an tuarascáil imréitigh bhainc mar seo a 

leanas: 

a. Féach ar liosta na n-íocaíochtaí amuigh agus na bhfáltas 

ar an ráiteas imréitigh bainc lena chinntiú go bhfuil siad 

cruinn ceart.  

b. Ba cheart gach iontráil dhúblach a cheartú.  

c. Ba cheart gach íocaíocht/fáltas atá níos sine ná sé mhí 

d’aois a iniúchadh. 

 

4. Áirithigh go ndéantar na hidirbhearta mionairgid agus cárta 

creidmheasa a bhreacadh síos i gcomhair na bliana agus go 

luaitear na hiarmhéideanna sa chuntas mionairgid agus carta 

creidmheasa i gceart ag deireadh na bliana. 

 

https://www.fssu.ie/post-primary/topics/sage-50-accounts/chart-of-accounts/chart-of-accounts/
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5. Áirithigh go bhfuil an t-iarmhéid sa Chuntas Rialaithe Airgid i 

gcomhréir le méid an airgid thirim agus na seiceanna atá á 

gcoimeád sa taisceadán ar an 31 Lúnasa 2021. 

 

6. Áirithigh go bhfuil an t-iarmhéid sa chuntas imréitigh íocaíochtaí 

ar líne (cód 1870) i gcomhréir leis an méid airgid atá dlite ón 

gcuideachta íocaíochtaí ar líne amhail ar an 31 Lúnasa 2021. 

 

7. Taifid phárolla: Déan taifid phárolla a phriontáil do na 

fostaithe faoi leith don tréimhse ón 1 Meán Fómhair 2020 go 

dtí an 31 Lúnasa 2021, déan cóip den achoimre párolla don 

bhliain 2020 a phriontáil agus bíodh cóip chúltaca den 

phárolla sábháilte agat ar mhéaróg chuimhne le haghaidh 

2020 agus suas go dtí an 31 Lúnasa 2021.  

 

8. CBL: Caith súil siar ar ROS lena chinntiú go ndearnadh na 

tuairisceáin CBL go léir a chomhdú. Cuimhnigh nach mór duit 

tuairisceáin CBL a chomhdú fiú amháin más ionann do 

dhliteanas agus toradh nialasach. 

 

9. RCT: Áirithigh go ndearnadh an hasbhaintí uile a baineadh ó 

Fhochonraitheoirí chun críocha RCT a thuairisciú chuig na 

Coimisinéirí Ioncaim  

 

10. Cumann na dTuismitheoirí: Áirithigh go gcuirtear an 

doiciméadúchán airgeadais uile ar fáil do chuntasóir/iniúchóir 

seachtrach na scoile lena chuimsiú i gcuntais airgeadais 

bhliantúla na scoile.  

 

11. Déan liosta creidiúnaithe de láimh amhail ar an 31 Lúnasa 

2021 (airgead atá dlite ag an scoil). Má úsáideann tú an 

mórleabhar ceannachán déan liosta a phriontáil de na 

creidiúnaithe gan íoc amhail ar an 31 Lúnasa 2021.  

 

12. Scríobh amach liosta féichiúnaithe & réamhíocaíochtaí de láimh 

amhail ar an 31 Lúnasa 2021 (airgead atá dlite don scoil). Má 

úsáideann tú an mórleabhar díolachán déan liosta a phriontáil 

de na féichiúnaithe gan íoc amhail ar an 31 Lúnasa 2021. 

 

13. Ba cheart ioncam a fhaightear sa bhliain reatha (2020/2021), 

don scoilbhliain seo chugainn (2021/2022) a thaispeáint mar 

ioncam a fuarthas roimh ré ar chód an chláir chomhardaithe 

2105 agus déan feidhm na roinne a úsáid chun anailís a 

dhéanamh ar na cineálacha éagsúla sa chuntas ainmniúil. 

Éascóidh sé seo tuarascáil ghníomhaíochtaí ainmniúla a 

reáchtáil de réir roinne do chód 2105 amhail ag an 

31.08.2021 chun críocha iniúchóireachta.   

 

14. Mar mhalairt ar sin, déan liosta de láimh d’ioncam/dheontais a 

fuair an scoil le linn a bliana 2020/2021 a bhaineann le 
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scoilbhliain 2021/2022 m.sh. deontas leabhar, táillí 

idirbhliana, táillí riaracháin na scoile, ranníocaíocht dheonach.  

15. Déan na deontais don bhliain a athbhreithniú lena chinntiú gur 

cuimsíodh na deontais uile a fuarthas don chéad scoilbhliain 

eile sna cuntais mar ‘Dheontais Faighte Roimh Ré’ (cóid 

ainmniúla 2150-2152).  

 

16. Déan an t-ioncam agus caiteachas a athbhreithniú maidir le 

haon deontais imfhálaithe agus tabhair ar aghaidh aon 

mhéideanna nach bhfuil caite mar dheontais gan chaitheamh.  

 

17. Cinntigh go bhfuil na hiarmhéideanna maidir le deontais Covid 

gan chaitheamh, cuimsithe mar is ceart sna cuntais. (Cuirfear 

oiliúint ar fáil mar sheimineár gréasáin ar ball) 

 

18. Cruthaigh Tuarascáil ar Ghníomhaíochtaí Ainmniúla agus 

seiceáil ar breacadh síos na hidirbhearta go cruinn lena chinntiú 

gur tugadh cuntas ceart orthu. 

 

19. Ba cheart Coigeartuithe Deireadh Bliana maidir le 

creidiúnaithe, féichiúnaithe agus ioncam faighte roimhe ré a 

bhreacadh in SAGE 50 ar an 31.08.2021 más féidir sula 

ligtear dóibh leanúint ar aghaidh go deireadh na bliana. 

 

 

E. Priontáil amach na Tuarascálacha Airgeadais atá molta le haghaidh 

dheireadh na bliana. 

Tuarascálacha Chun Tuarascálacha a Rith 

Comhardú Trialach Nominal codes > Trial Balance 
Nominal codes > Reports > Trial Balance 

Clár Comhardaithe Nominal codes > Reports > My nominal code reports >BOM 
Balance Sheet 

Brabús agus 
Caillteanas 

Nominal codes > Reports> My nominal code reports>BOM 
Income & Expenditure Account 
 

Gníomhaíocht 
Ainmniúil  

Nominal codes > Reports> Nominal Activity 
 

Íocaíochtaí / Fáltais 
Neamhréitithe 

Bank accounts > Reports > Unreconciled transactions 
 

Tuarascáil ar 
chreidiúnaithe 
aosaithe 
(le haghaidh 
scoileanna a 
úsáideann modúl an 
tSoláthraí amháin) 

Suppliers > Reports > Aged creditors > Aged creditors 
summary  
Suppliers > Reports > Aged creditors > Aged creditors 
detailed 
Suppliers > Reports > Activity > supplier activity detailed 
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Tuarascáil ar 
fhéichiúnaithe 
aosaithe 
(le haghaidh 
scoileanna a 
úsáideann modúl an 
Chustaiméara 
amháin) 
 

Customers > Reports > Aged debtors > Aged debtors analysis 
summary  
Customers > Reports > Aged debtors > Aged debtors analysis 
detailed 
Customers > Reports > Activity>customer activity detailed 
 

Tuarascáil na Roinne 
do chód 2105 

Department > Reports > Nominal Analysis > Nominal 
Department analysis detailed > cód ainmniúil 2105 agus an 
réamhshocrú ar na huimhreacha roinne 
 

 
 
 

Tuarascáil roinne  
 
Le haghaidh 
idirbhearta covid 
 

Departments > Reports > Nominal Analysis > Nominal 
Department analysis detailed > baineann roinn 1 le covid sa 
sampla seo Lig mé don cód ainmniúil a bheith réamhshocraithe 
ionas go dtabharfaidh sé gach cód ina sanntar roinn 1. 
 

 
 
NB: Mura sannadh uimhir na rannóige ábhartha d’idirbhearta covid ní 
bheidh siad le feiceáil sa tuarascáil seo. 

 

 

F. Cóip Chúltaca den Chóras 
 

Déan DHÁ Chóip chúltaca ar a laghad agus déan iad a shábháil in dhá 
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shuíomh ar leithligh (Líonra/tiomántán crua seachtrach). Tabhair ‘Roimh 
Dheireadh na Bliana mar ainm air ’ - tá sé ríthábhachtach cóip chúltaca a 
dhéanamh de na sonraí sula ndéanfar deireadh na bliana a rith, toisc gurb é sin 
an t-aon bhealach chun dul ar ais go dtí staid réamhbhliana.  
Féach ar Chuid G maidir le deireadh do bhliana a rith i Sage 50. Is féidir 
tuilleadh eolais nó soiléiriú a fháil ar aon cheann de na saincheisteanna sa 
Treoirlíne seo ach dul i dteagmháil le FSSU.  

 

G. Deireadh Bliana a Phróiseáil in Sage 50 
Ba cheart do scoileanna idirchaidreamh a dhéanamh lena gcuntasóirí/lena n-

iniúchóirí seachtracha agus a iarraidh orthu a gcuid cuntas a athbhreithniú chomh 

luath agus is féidir agus Dréacht-chomhardú Trialach a chur isteach, ina n-áireofar 

athruithe ar na cuntais ioncaim agus caiteachais don bhliain. Féadfar na 

coigeartuithe iniúchta a bhfuil gá leo a chur isteach i Sage 50 sula ndéanfar 

deireadh na bliana a phróiseáil agus beidh na figiúir le haghaidh Ioncaim agus 

Caiteachais a bheidh le feiceáil sna cuntais arna gcur i gcartlann i gcomhréir, tríd 

is tríd, leis na Ráitis Airgeadais sínithe amhail ar an 31.8.2020. Má bhíonn 

tuilleadh athruithe i gceist tar éis próiseáil dheireadh na bliana, féadfar na 

coigeartuithe a dhéanamh ar chóid an Chláir Chomhordaithe dar dáta an 

31.08.2021. 

Tá deireadh bliana bog ag Sage 50, rud a chiallaíonn gur féidir leat breacadh i 
do bhliain airgeadais nua sula ritheann tú an rogha Deireadh Bliana. Tá sé 
tábhachtach deimhin a dhéanamh go bhfuil dáta an idirbhirt i gceart. Beidh 
teachtaireacht le feiceáil ina gcuirfear in iúl go bhfuil an dáta lasmuigh den bhliain 
airgeadais reatha, cliceáil ar Ok nó Tá.  Féadfar na tuarascálacha seo a leanas 
a rith i leith na bliana airgeadais nua go dtí go ritheann tú deireadh na bliana - 
Brabús agus Caillteanas ó Idirbhearta, Cláir chomhardaithe na nIdirbheart agus 
tuarascálacha ar Chomharduithe Trialacha na nIdirbheart. Tabhair faoi deara le 
do thoil go bhfuil na tuarascálacha sin beartaithe le haghaidh úsáid 
inmheánach/oifige agus nár cheart iad a úsáid le haghaidh cruinnithe an Bhoird 
Bhainistíochta.  

Chun tuarascálacha an Bhoird Bhainistíochta a rith i gcomhair na bliana nua, lena n-
áirítear an buiséad le haghaidh 2021/2022 agus figiúir na bliana roimhe sin, ní mór 
Deireadh na Bliana Airgeadais a rith in Sage 50. Dá bhrí sin, ní féidir an próiseas 
deireadh bliana seo a chur siar rófhada sa Bhliain Airgeadais nua ar mhaithe 
le coigeartuithe iniúchta. 

Má tá cianrochtain sonraí á húsáid agat i Sage 50, ba cheart duit an gnáthamh 
deireadh bliana a rith ar an ríomhaire atá ainmnithe mar phríomhshuíomh faoi 
Help/About (Cabhair/Faoi) i Sage 50. I gcás go bhfuil Sage suiteáilte ar líonra, 
ba chóir an gnáthamh deireadh bliana a rith ar an ríomhaire ar a bhfuil na sonraí. 
Má tá tacar mór sonraí agat, féadfaidh roinnt ama a bheith i gceist leis an 
bpróiseas a rith. Laghdófar an tréimhse ama sin má ritheann tú an gnáthamh ar 
an ríomhaire ar a gcoinnítear sonraí do chuntas. 
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1. Deireadh na Bliana Airgeadais a Rith 

• Athraigh dáta an chláir-athraigh dáta an chláir go dtí lá deireanach na bliana 
airgeadais, m.sh. an 31 Lúnasa 2021. 

• Déan DHÁ chóip chúltaca agus cuir an lipéad ‘Before Year End’ orthu - tá sé 
ríthábhachtach cóip chúltaca a dhéanamh de na sonraí sula ndéanfar deireadh 
na bliana a rith, toisc gurb é sin an t-aon slí chun dul ar ais go dtí staid 
réamhbhliana. Moltar dhá chóip chúltaca a dhéanamh mar réamhchúram ar 
eagla go ndéanfaí damáiste do na meáin chúltaca nó go gcaillfí ceann díobh. 

• Chun Deireadh Bliana a rith, roghnaigh Tools >Period End >Year End.  

• Ansin taispeánfar an fhuinneog deireadh bliana agus cuirfear na céimeanna 
go léir i gcrích. 

• Archive Data - roghnaigh an rogha seo chun sonraí a chur i gcartlann. Ar an 
mbealach sin beidh tú in ann féachaint ar sheansonraí gan seanchóipeanna 
cúltaca a thabhairt ar ais.  

• Seiceáil go bhfuil na sonraí a thaispeántar ag bun na fuinneoige Deireadh 
Bliana ceart sula roghnaíonn tú an rogha Rith Deireadh Bliana.  

• Roghnaigh YES má tá na dátaí Deireadh Bliana ceart.  

• Beidh scáileán dul chun cinn deireadh bliana le feiceáil ansin. Nuair a bheidh 
sé curtha i gcrích fiafrófar díot an mian leat iris Deireadh Bliana a phriontáil. 
Cliceáil ar ok. 

• Beidh teachtaireacht deiridh le feiceáil le deimhniú go bhfuil deireadh an 
bliana airgeadais curtha i gcrích, cliceáil ar OK. 

2. Déan na Sonraí a Sheiceáil Tar Éis Deireadh na Bliana a Rith  

Déan comhardú trialach Tugtha Ar Aghaidh a rith. Roghnaigh Modules 
>Nominal codes >Trial Balance i gcomhair na tréimhse roghnaigh Brought 
Forward 
 

• Deimhnigh nach bhfuil aon chóid ioncaim agus caiteachais ar an tuarascáil sin 

• Ansin, déan do shonraí a sheiceáil arís. File>Maintenance > check Data 

• Ar deireadh, déan cóip chúltaca eile de na sonraí agus cuir ‘After Year End’ 

mar lipéad uirthi. 

• NÁ déan an rian iniúchta a ghlanadh. Má tá sonraí cuntasaíochta le haghaidh 
níos mó ná dhá bhliain ar Sage 50 áfach, agus gur cosúil go bhfuil próiseáil 
Sage moill mar thoradh ansin ba cheart smaoineamh ar an rian iniúchta a 
ghlanadh. Féach an rannán Sage 50 den láithreán gréasáin le haghaidh sonraí 
maidir leis an bpróiseas sin. 
 
Tá sonraí iomlána maidir le deireadh bliana a rith le fáil sa ‘Lámhleabhar 

FSSU ar Chuntais SAGE - Cuid 8’. 

https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
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3. Ba cheart Buiséad na Scoile le haghaidh 2021/2022 a iompórtáil anois, 
féach ar 

‘Lámhleabhar FSSU ar Chuntais SAGE -Cuid 2.7’ le haghaidh treorach. 

Déan deimhin de go bhfuil na cóid ainmniúla céanna ag do theimpléad 
iompórtála buiséid agus atá ann i do chuntais Sage 50 agus go ndéanfar 
cóip chúltaca sula ndéantar an fhaisnéis a iompórtáil.  

4. Nuair atá deireadh na bliana rite, ba cheart an dáta 31.08.2021 a chur le 
haon choigeartuithe iniúchta ar Chuntais 2020/2021 agus ní ceart iad a 
dhéanamh ach i leith cóid an Chláir Chomhardaithe agus ba cheart 
coigeartuithe Ioncaim agus Caiteachais a bhreacadh i gcód Cúlchistí Ioncaim 
2710. 

5. Do na scoileanna sin ar mian leo go mbeadh comparáidí idir an bhliain roimhe 
agus an bhliain reatha go dtí seo le feiceáil ina gCuntas Ioncaim agus 
Caiteachais in ionad na bliana roimhe ina hiomláine, tá an tuarascáil roghnach 
sin mar aon le treoracha maidir lena gcóipeáil isteach i Sage 50 le fáil sa chuid 
Ag tosú le Sage 50 dár láithreán gréasáin. 

H. Uasghrádú chuig Sage 50cloud Accounts 

Meabhrúchán go gcaithfidh gach Meánscoil Dheonach uasghrádú a dhéanamh chuig 

Sage 50cloud Accounts a thugann gnéithe nua leis lena n-áirítear fothaí bainc agus 
feabhsúcháin maidir le bainistiú cianrochtain sonraí. Laghdóidh fothaí bainc an méid 
ionchuir láimhe go mór agus dá bhrí sin laghdóidh siad an méid ama a thógfar chun 
na tuarascálacha míosúla a phróiseáil. Is féidir sonraí breise a fháil anseo. 

I. Oiliúint maidir le Sage 50 

Beidh sraith seimineár gréasáin ar Sage 50 á reáchtáil againn i rith mhí Mheán 
Fómhair, ina ndíreofar faoi leith ar conas an gnáthamh deireadh bliana a thabhairt 
chun críche.  

Cuirfidh an FSSU tacaíocht agus oiliúint leanúnach ar fáil chun éascú a dhéanamh agus 
cabhrú le scoileanna na gnéithe nua atá ar fáil in Sage 50cloud Accounts ag tosú le 
húsáid fothaí bainc mar go bhféadfaidh sé seo cur le héifeachtúlacht agus tráthúlacht 
fheidhm na gcuntas. 

Guthán: 01-269 0677  

info@fssu.ie  

 

An 1 Meán Fómhair 2021 

 

https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/post-primary/topics/sage-50-accounts/upgrading-to-sage-50cloud/schools-new-to-sage-50/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/upgrading-to-sage-50cloud/schools-new-to-sage-50/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/upgrading-to-sage-50cloud/
mailto:info@fssu.ie

